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书名 

《Axure快速原型设计》——Axure Rapid Prototyping 

 

作者简介 

 
 

陈良泳，目前任职于北京某管理软件公司，致力于以用户为中心的软件产品设计，提倡在软件设计开发过程中应

用可用性工程。 

MSN：liangyongchen@hotmail.com 

WebSite： www.chenliangyong.com 

Blog：www.prototype001.cn（旧址是www.xlynx.net） 

 

为什么要使用Axure？ 

Axure RP 可以让桌面应用软件和Web网站的设计师创建线框图、流程图、原型和规格说明文档，它比任何当前

其它创建静态原型的工具如Visio, Omnigraffle、Illustrator、 Photoshop、Dreamweaver, Visual Studio、

FireWorks、GUI Studio等都要快速、高效，因为它才是真正的专门原型设计工具，并且支持多人协作设计和版

本控制管理。 

 

设计师们渴望有一个专门的原型设计利器，而Axure正是为此目的而精心打造。Axure RP已经被一些财富1000大

公司采用，成为创造成功产品的必备工具。国内的淘宝、雅虎、腾讯、当当等公司的产品经理也都在使用。 

 

读者受众 

本书读者受众包括（也即是Axure RP的使用者）：商业分析师、信息架构师、可用性专家、产品经理、IT咨询师、

用户体验设计师、交互设计师、界面设计师等。另外，也推荐架构师、程序开发工程师阅读。 
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为什么要进行原型设计 
 

1、原型的作用和好处 

―没有比制作prototype更易取得使用者界面与特殊功能可用性上的一致性了。Prototype不只可确认需求，它更可

赢得顾客的心。‖ 

——阿伦M.戴维斯 和 迪安A. 莱芬韦尔 

《用需求管理快速交付高质量的软件》的作者（Rational软件公司/IBM） 

 

根据调查报告显示，大约66%的软件开发不是失败，就是超预算、延期或交付缩水的功能。软件失败或亏损的前

三大原因为： 

1、缺乏使用者的参与； 

2、需求或规格不完整； 

3、需求或规格变更； 

 

传统的需求管理工具或工作表中所储存的数千个需求与上百页的文件早已不合时宜。现在，这些需求更是不适用

于目前快速发展的环境。而制作Prototype是个有效的简化文档编制、吸引使用者参与、早期辨认需求遗漏、将外

在需求风险降到最低的方法。将大量文字性文档转变为带有注释与互动性的可视画面，如此更能抓住利益相关者

与使用者的注意，让用户在软件开始投入编程前就确认需求。 

 

快速原型法（Rapid Prototyping）是一种有效且高效的以用户为中心（User-Centered Design）的技术，可以帮

助用户体验专家、设计师、工程师创造更加有用、可用的产品。 

 

目前全球有财富1000大的公司和重要机构在使用Axure RP，国内的淘宝、雅虎、腾讯、当当等公司的产品经理

也都在使用。 

 

基础篇 
在基础篇中，你将完整的学习到关于Axure的基本和高级功能。 

 

第一章 介绍 
让你初步认识Axure。 

 

第1节 认识 Axure RP 
 

1、什么是Axure？  

Axure的完整英文名是Axure RP Pro。Axure的英文发音是―Ack-sure‖ ，RP 是―Rapid Prototyping‖的缩写，意思

为快速原型设计；Pro是―Professional‖的缩写，意思是专业版。Axure RP Pro是美国Axure Software Solution 公

司的旗舰产品，是一个让负责定义需求和规格、设计功能和界面的专家快速创建应用软件或Web网站线框图、原

型、规格说明书的专业快速原型设计工具。Axure所针对的专家包括用户体验设计师（UX）、交互设计师（UI）、

业务分析师（BA）、信息架构师（IA）、可用性专家（UE）和产品经理（PM）。 



 

 
   

 

在Axure中设计线框图和原型会使你更加高效；可以让团队成员一起体验你的设计；向用户演示和交流以确认用

户需求；自动产生规格说明书；让团队进行多人协同设计和对版本进行管理控制；等等。  

 

总之，Axure会使你以往的工作方式发生变革：  

进行更加高效的设计；  

体验到动态的原型；  

清晰有效的交流想法；  

 

2、Axure工作环境介绍 

Axure的可视化工作环境可以让你轻松快速的以鼠标拖曳的方式创建带有注释的线框图。不用进行编程，就可以

在线框图上定义简单链接和高级交互。在线框图的基础上，可以自动生成HTML原型和Word格式的规格说明书。 

 

以下是Axure RP工作环境的简要说明：  

 

 

1.  主菜单和工具栏 

执行常用操作，如文件打开、保存文件，格式化控件，自动生成原型和规格说明书等操作。  

2.  站点地图面板 

对所设计的页面（包括线框图和流程图）进行添加、删除、重命名和组织页面层次，。  



 

 
   

3.  控件面板 

该面板中包含了线框图控件和流程图控件，如按钮、图片、文本面板、矩形框等，可用这些控件进行线框图

和流程图的设计。 另外，你还可以载入已有的部件库（*.rplib文件）和创建自己的部件库。 

4.  模块面板 

模块是一种可以复用的特殊页面，在该面板中可进行模块的添加、删除、重命名和组织模块分类层次。  

5.  线框图工作区（或叫页面工作区） 

线框图工作区是你进行原型设计的主要区域，在该区域中你可以设计线框图、流程图、自定义部件、模块。   

6.  页面注释和交互区  

添加和管理页面级的注释和交互。  

7.  控件交互面板 

定义控件的交互，如：链接、弹出、动态显示和隐藏等。  

8.  控件注释面板 

对控件的功能进行注释说明。   

 

第2节 线框图及注释 
现在我们来认识Axure中与设计线框图有关的各个区域和面板，说明如何设计线框图和为线框图添加注释。 

 

1.  站点地图面板 

在开始设计线框图(Wireframe)或流程图（Flow）之前，应该先考虑页面框架，决定信息内容与层次。明确页面框

架后，就可以利用站点地图面板来建立和管理所要设计的页面，添加、删除页面及对页面层次进行组织。   

 

添加和删除页面 

在站点地图面板中，点击面板工具栏上的―Add Child Page‖按钮可以添加一个页面；点击面板工具栏上的 ―Delete 

Page‖按钮或在页面上点选右键菜单中的 ―Delete Page‖选项可以删除一个页面；在页面上点选右键菜单中的

―Rename Page‖菜单项或鼠标缓慢双击页面可对页面进行重命名。 



 

 
   

 

 

组织页面层次 

在站点地图面板中，用鼠标拖曳一个页面到另一个页面上或点击面板工具栏上的―Move Up‖、―Move Down‖、

―Indent‖、 ―Outdent‖按钮，就可以组织页面的层次和顺序。   

 

 

打开页面进行设计 

在站点地图面板中，用鼠标在页面上进行双击或点击面板工具栏上的―Design Page‖按钮，打开该页面在线框图区

域中进行线框图设计。 

 



 

 
   

 

2、部件面板（控件面板） 
 

控件是用于设计线框图的用户界面元素。在控件面板中包含有常用的控件库，如按钮、图片、文本框等。  

 

添加控件  

从控件面板中拖动一个控件到线框图区域中，就可以添加一个控件。控件可以从一个线框图中被拷贝(Ctrl+C)，

然后粘贴(Ctrl+V)到另外一个线框图中。  

 

操作控件  

添加控件后，可在线框图中选择该控件进行鼠标拖曳移动该控件和改变控件大小，还可以一次选择多个控件进行

移动和改变大小。另外，还可以组合、排序、对齐、平均间距（Distribute）和锁定控件。以上这些操作可通过在

控件上点击右键菜单进行，也可以通过选择菜单―View->Toolbars->Object ‖调出的对象工具栏上的按钮进行。 

  

编辑控件风格和属性  

有多种方法可以编辑控件的风格和属性：  

 鼠标双击：鼠标双击某个控件，可以对控件的最常用的属性进行编辑。例如，双击一个图片控件可以导入一张

图片；双击一个下拉列表或列表框控件可以编辑列表项。   

 工具栏：点击工具栏上的按钮可编辑控件的文本字体、背景色、边框等。  

 右键菜单： 通过在控件上点击右键菜单，编辑控件的一些特定属性，不同的控件这些属性也各不相同。   

 

 

查看和搜索控件 

控件面板工具栏中，点击―Wireframe‖会弹出一个下拉菜单，你可以查看所有控件库，或只看默认线框图或流程图

控件库，或只看已经被加载的控件库。另外，你还可以加载已有控件库、创建新控件库、编辑当前控件库、或更

新控件库。 



 

 
   

 

 

点击―Search‖这个搜索按钮，输入想要查找的控件名称，会在面板内列出所有符合条件的控件。 

 

 

 

创建自定义控件库 

默认的两套控件库(Wireframe和Flow)可能还不能满足你的要求，那么现在你可以开始创建你自己的控件库了。在

控件面板中点击下拉菜单的―Create library‖选项，这时会弹出一个保存对话框让对这个.rplib文件进行命名和保存，

Axure会立刻启动另一个执行程序并打开这个刚建好的 .rplib文件。在新的Axure程序界面中，原本站点地图面板

的位置会被控件库面板(Widget Library Pane)所取代。你可以像页面一样对控件进行新增、删除、排序。 



 

 
   

 

像创建页面一样，你可以利用现有的控件来绘制新创建的控件。 

 

Axure启动时，如果已经把创建好的自定义控件库(.rplib文件)放在Windows文件夹的―我的文件> My Axure RP 

Libraries‖目录中，则该控件库会被自动加载到控件面板中。另外，你也可以手动选择你所指定的 .rplib 文件进行

控件库加载。 

 

使用自定义控件库 

新建立的自定义控件库的操作方式就如同其它的默认控件库一样，以拖放(Drag&Drop)的方式将控件放到画布上

进行画面的绘制。 

 

 



 

 
   

3.  控件注释 

可以为控件添加注释，以说明控件的功能。  

 

添加注释  

在线框图中选择控件，然后在控件注释面板中为各个注释项（如Specification、Status等）输入文本， 即可为控

件添加注释。面板顶部的Label输入框是为控件添加一个标识符（即控件在线框图中的命名）。   

 

 

自定义注释项  

通过主菜单‖Wireframe->Customize Annotation Fields and Views―或点击注释面板头部的 ―Custommize Fields 

and Views‖ 或， 然后在弹出的自定义字段和视图（Custommize Fields and Views）对话框中可以添加、删除、

修改、排序控件的注释项。 



 

 
   

 

 

建立新注释视图 

在自定义字段和视图对话框中，你还可以建立新的注释视图。你可在对话框底部的Add new view后的输入框中输

入新视图的名称，点击Add按钮即可添加新的注释视图。 

 
 

你可以点击Edit按钮，为新的注释视图建立注释项： 



 

 
   

 
 

然后在Axure主界面的注释面板中，可以看到新建立的注释视图和注释项。 

 
 
 

脚注（Footnotes）  

脚注用于对于线框图和规格书中的控件进行编号标识。在控件上添加注释或动作后，会在控件的右上角会显示一

个带数字的黄色方块，称为脚注。脚注号码可以增大和减小， 可通过控件右键菜单的―Footnotes‖菜单项或工具

栏上的 和  按钮进行修改。  

 

4.  页面注释（Page Notes）  

页面注释是对页面进行详细描述和说明。  

 

添加页面注释  

在线框图区域下的页面注释面板中可以添加页面注释内容。  

 



 

 
   

 

管理页面注释 

另外，可以自定义页面注释项，为不同的利益相关者和团队成员提供不同的页面描述说明，以满足不同需要。比

如可以新增―设计师‖、―老板‖等不同类别的页面注释项。当输出规格文件时，可以指定哪些页面注释项要输出。  

 

要添加页面注释项，点击主菜单―Wireframe->Manage Page Notes‖或点击页面注释面板上的―Page Notes - 

Default‖旁边的箭头按钮，然后选择―Manage Page Notes‖，将出现页面注释对话框，然后就可以添加、删除、重

命名、排序页面注释项。  

 

要在各个注释项间进行切换，可以点击―Page Notes – Default‖旁边的箭头按钮，然后选择想要的注释项进行页面

注释。  

 

第3节 固定图片的边角 
 
固定图片边角的功能，允许你放大缩小图片时，只对中间的某个区域进行缩放，保持图片的边角不变形。 

对于图形控件界面，这种效果会使得图片放大缩小后，仍有效保持视觉上的合理性。要调整图片的边角固定范围，



 

 
   

在图片以鼠标右键选择―Edit Image->Preserve Corners‖。 

 

进入调整边角固定范围的编辑模式之后，在控件的上方及左方个出现两个小箭头，调整这两个箭头位置（上下或

左右），就可以决定这个图片控件被放大缩小时的边角固定范围。 

 

 



 

 
   

指定好图片的边角固定范围后，即使将该窗口图片控件放大或缩小，我们还是可以看到一个很合理的窗口，边角

的呈现不致于因图片本身放大缩小而失真。 

 

 

 

 

第4节 Axure5.5绘图功能的加强 
 
以圈选模式选取控件(类似Visio/PowerPoint模式) 

Axure RP默认选取控件的模式是―交叉选区模式‖，也就是鼠标指标点选拖曳所到之处，只要被这个范围碰触到的

控件，就会被选取。现在增加了一个新的选取模式―全选模式‖，使得只有那些完全被鼠标指标所画出的矩形区域

包围者才会被选取。这种软件操作模式就跟操作Visio或PowerPoint一样。 

 

想要改变选取模式，点选工具列的―Select Contained Mode‖按键(如图)，或直接按 CTRL-F9。 

 



 

 
   

 

选取群组内的控件 (Deep Selection in Groups) 

当控件被群组(Group)起来以后，新版Axure RP 5.5允许你针对群组中的单一控件进行编辑，增加批注，或设计交

互表现，甚至可以移动或缩放群组中的控件尺寸与位置。要选择群组中的控件是很简单的，只要以鼠标左键去点

选你要的控件即可。 

 

 

位置与尺寸设定面板(Location and Size Pane) 

位置与尺寸设定面板(Location and Size Pane)取代了先前版本的位置与尺寸对话窗(Location and Size dialog)。

要开启这个窗格，以鼠标右键在控件上选择―View->Location and Size‖即可。 

当你在绘制画面时，这个面板现在可以维持出现在画面上不会消失，方便随时调整位置与尺寸大小的数值。这个

新功能可以针对单一控件或多个控件一次性的调整，当你想要对齐一群相同特性的控件时，这个功能让你更快设

定控件等宽或等高，更容易对齐控件位置。 

 

 

第5节 基本交互设计 
本节介绍了设计低保真原型所需要的简单的交互行为，解释了Axure中进行交互设计的基本方法。 

 

1、控件的交互  



 

 
   

控件交互面板用于定义线框图中控件的行为，包括定义简单的链接和复杂的RIA 行为，所定义的控件交互可以在

将来生成的HTML原型中进行操作。  

 

 

在控件交互面板中可以定义的控件交互由事件（Events）、场景（ Cases）和行为（Actions）组成：  

 用户操作界面时就会触发事件， 如鼠标的OnClick、OnMouseEnter和OnMouseOut；  

 每个事件可以包含一个或多个场景，场景就是事件触发后出现的一种情况，如点击一个按钮后可以出现两种场

景：一种是进入页面1；另一种是进入页面2；  

 每个场景中可执行多个行为，例如：打开链接、显示面板、隐藏面板、移动面板。  

 

 

事件、场景和行为的关系如下： 



 

 
   

  

 

目前Axure RP 5.5 支持的事件如下：  

 OnClick：鼠标点击  

 OnMouseEnter：鼠标的指针移动到对象上   

 OnMouseOut：鼠标的指针移动出对象外   

 OnFocus：鼠标的指针进入文字输入状态（获得焦点）   

 OnLostFocus：鼠标的指针离开文字输入状态 （失去焦点）   

 OnChange：下拉框或列表框中的选项改变 

 OnPageLoad：页面或模块载入  

 OnKeyUp：按下然后松开键盘上的键 

 

大多对象只具备常见的三种触发事件：OnClick、OnMouseEnter 与OnMouseOut。某些控件可触发的事件有些

不同：  

 单选框和复选框则具有OnFocus、 OnLostFocus 事件； 

 文本框、文本域、下拉框、列表框则具有OnKeyUp、OnFocus、OnLostFocus事件； 

 下拉框和列表框具有OnChange事件； 

 页面加载或模块被载入时则发生OnPageLoad ； 

 

2、定义一个链接  

下列步骤说明如何在按钮控件上定义一个链接：  

1.  首先，拖拉一个按钮控件到线框图中，并选择这个按钮；  

2.  然后，控件交互面板中鼠标双击―OnClick‖这个事件，这时会出现―Interaction Case Properties‖对话窗，在这

个对话框中可以选择要执行的动作；  

3.  在―Step 2‖中，勾选―Open Link in Current Window‖动作；   

4.  在―Step  3‖中，点击―Link‖，在弹出的Link Properties 对话框中可以选择要链接的页面或其它网页地址 。 



 

 
   

 

除了上面的步骤，定义一个链接的最快捷的方法是单击控件交互面板顶部的 ―Quick Link‖ ，在弹出的Link 

Properties 对话框中选择要链接的页面。  

 

3、定义行为 

除了定义简单的链接之外，Axure还提供了许多丰富的行为，可以在任何所触发事件的场景中执行这些行为。  



 

 
   

 

 

以下是目前 Axure5.5所支持的行为：  

Open Link in Current Window：在当前窗口打开一个页面  

Open Link in Popup Window：在弹出的窗口中打开一个页面  

Open Link in Parent Window：在父窗口中打开一个页面  



 

 
   

Close Current Window：关闭当前窗口   

Open Link in Frame：在Frame框架内打开一个页面  

Open Link in Parent Frame：在父页面的嵌框架中打开一个页面   

Set Panel state(s) to State(s)：为动态面板设定要显示的状态   

Show Panel(s)：显示面板  

Hide Panel(s)：隐藏面板  

Toggle Visibility for Panel(s)：切换（显示/隐藏）面板的显示状态  

Move Panel(s)：根据绝对坐标或相对坐标来移动动态面板  

Bring Panel(s) to Front：将动态面板移至最上层，让Dynamic Panel能够不被其它图层覆盖 

Set Variable and Widget value(s) equal to Value(s)：设定变量的值或控件的值 

Scroll to Image Map Region：滚动页面到Image Map所在位置 

Enable Widget(s)：把对象状态变成可用状态   

Disable Widget(s)：把对象状态变成不可用状态   

Set Widget(s) to Selected State：指定控件选择后的样式  

Set Focus on Widget：设定焦点在指定的控件上 

Wait Time(s)：等待多少毫秒(ms)后再进行这个动作 

Other：显示动作的文字说明 

 

4、定义多个场景（场景说明） 

一个事件可以包含有多个场景，以传达多个不同的流程或交互。例如，可以在一个按钮的 OnClick事件中加入两

个场景，第一个场景为―如果成功‖并执行第一个动作；第二个场景为―如果失败‖并执行第二个动作。 

 

 

当在HTML原型中点击按钮时，会显示出这两个场景说明(―如果成功‖和―如果失败‖)，点选其中一个场景说明，就

会执行这个场景中包含的行为。   



 

 
   

 

使用场景说明虽然也可以表达出交互流程，但如果需要建立一个高保真的原型，则必需在场景中定义逻辑条件： 

根据控件中的值或变量值执行行为。 （见第四章中关于逻辑条件的详细描述） 

 

5、页面事件: OnPageLoad  

Axure支持一个页面级的触发事件：OnPageLoad，这个事件在原型载入页面时被触发。  页面OnPageLoad 事

件在页面交互面板中定义，为页面OnPageLoad 事件添加场景的方式与在控件事件中相同。 （见第四章中关于

OnPageLoad事件的详细描述） 

 

 

 

第6节 模块 
 

1、什么是模块  

模块（Maste）是可以重复使用特殊页面。一些常用模块如页首(Header)、页尾(Footer)与导航(Navigation)。模

块可用在页面中或是其他模块中。只要修改模块，在所有引用这个模块的页面中的模块也会相应跟着同步更新。  

模块的概念犹如PowerPoint 中母版、Dreamveawer中模板的概念，熟练掌握模块可以大大提高原型设计的效率，

并使原型易于管理维护。  

 

2、添加、设计和组织模块  

在模块面板中可进行模块的管理。 要添加模块，单击模块面板顶部工具栏的―Add Master‖按钮或在面板中点鼠标 

右键，选择―Add Master‖。 可以使用文件夹(Folder)来组织模块，然后通过工具栏、右键菜单或是拖放的方式重

新排列组织模块。 在模块上双击可打开模块，像设计页面一样拖放控件到线框图中进行模块设计。   

 



 

 
   

 

3、页面中添加模块  

拖动模块面板中的模块到线框图中，就可以在页面或其它模块中添加模块。模块添加到线框图中后，根据模块行

为会有淡红或灰色的遮罩。 选择菜单  ―Wireframe->Mask Masters‖，取消该菜单的勾选，就可以移除颜色遮罩。  

模块的默认行为（Behavior）是―Normal‖ ，可以在模块上点击鼠标右键，使用―Behavior‖菜单项将模块行为修改

为―Place In Background‖或―Custom Widget‖。  

 

 

模块有以下3种行为： 

 普通行为（Normal）：模块可以被移动与放置在线框图中的任何地方，对模块所做的修改会在所有模块实例

中同时更新。 

 背景行为（Place in Background）：模块应用在线框图中时，会处于线框图的最底层并被锁定。模块实例中

所包含控件的位置与在模块中的位置相同，常用于作为模板、布局、底板。  

 自定义控件行为（Custom Widget）： 模块应用在线框图中时，模块实例中的控件与原模块失去关联，模块

实例中的控件可以像一般控件一样可以进行编辑，就好像只是进行了复制和粘帖操作。常用于创建具有自定义

属性、注释和交互的自定义控件库，例如：具有白色文字的蓝色按钮。   

 

第7节 HTML原型 
 

1、什么 HTML原型  

在 Axure中设计了带注释的线框图并定义了交互之后，就可以产生一个可以基于浏览器的、可互动的原型了。

Axure 原型是一些HTML和 JavaScript 文件，可以在IE6+、Mozilla、Firefox浏览器中运行。  

 

2、配置和生成原型  

点击主菜单―Generate->Prototype (F5)‖或工具栏上的Prototype按钮，在打开的 Configure HTML Prototype对话

框中，可以对原型进行配置和生成。  



 

 
   

 

 

生成原型的配置选项分为以下部分：  

 常规（General）：在―Destination Folder‖位置输入 HTML原型的存放位置。由于Axure HTML原型包含多个文

件，最好指定一个单独文件夹专门存放这个原型。  

 页面注释（Notes）：对想要显示在 HTML原型中的页面注释项进行选择和排序。  

 控件注释（Annotations）：对想要显示在HTML 原型中的控件注释项进行选择和排序。  

 定交互行为（Interactions）：设置是否需要总是显示场景描述(case)，或是只在多个场景存在的情形才显示场

景描述。  

 发布（Distribution）：选择是否发布生成chm文件。  

 高级（Advanced）：选择是否将Text Panel转换成图片，这是旧版本的一个功能，很少使用。  

 

 

配置完毕后，就可以点击Generate按钮生成原型。  

 
 

3、重新生成页面  

当 Axure工程会越来越大时，输出HTML原型所耗费的时间也会越来多，导致速度变慢。如果只是调整其中一个

页面，却要等待整个原型重新全部输出，那就太浪费时间了。 这时为了提高效率，可以只对当前修改的页面进

行重新生成。 



 

 
   

要对一个页面重新生成，只打开这个页面，然后选择主菜单―Generate->Regenerate Current Page to 

Prototype(CTRL+F5)‖ ，回到 HTML原型中刷新就可以看到更新的页面了。   

 

 

4、使用HTML原型  

Axure输出的HTML原型的界面可分成三个区域：  

 左侧（站点地图）: 是一个页面导航列表，以层级形式展示原型中的页面。  

 底部（页面注释）: 显示当前页面的注释。  

 中间（线框图）: 显示线框图和流程图，线框图可以按照所设计的交互进行鼠标和键盘的互动。 另外，单击线

框图中控件旁边的黄色便利贴小图标可以阅读控件注释。 

 

 

5、发布原型  



 

 
   

Axure原型是一些 HTML、Javascript和图像文件，可以在主流的浏览如IE6+、Firefox中进行浏览。所以你的同

事和客户不需要安装 Axure 或任何播放器就可以直接浏览原型。  

发布Prototype的方式有很多种：  

1、发布到web服务器  

第一种方式是发布 HTML原型到Web服务器上，只要将网址告诉客户、工作伙伴或其他人，他们就可以在浏

览器上浏览原型。  

2、 压缩成ZIP压缩包  

第二种方式是将HTML原型压缩成ZIP包，然后将 ZIP压缩包传递给相关人员。其它人通过ZIP压缩包便可以

直接在自己的计算机上浏览 HTML原型。  

3、 发布为 CHM文档  

第三种方式是发布为CHM文档，就像ZIP 压缩包一样，这种方式是将原型发布为一个单独的文档，不需安装

任何软件就可以访问。CHM 是 Microsoft HTML Help 格式文档，因为大多数的Windows计算机已经安装了

浏览器， 所以使用者只要打开CHM文档就可以浏览原型。   

 

想要输出 CHM原型文档，请在Configure HTML Prototype对话框的 Distribute中，勾选―Create HTML Help 

File(.chm)‖选项。如果你未安装HTML Help Workshop的话，就必须先安装它才能产生CHM档。安装完成

HTML Help Workshop 后，所安装的文件夹中将 

会出现一个hhc.exe的文件，单击―Locate hhc.exe‖链接到hhc.exe文件的位置。最终产生的CHM原型文档存

放在原型所在的文件夹中。  



 

 
   

 

 

第8节 输出规格说明书 

1、什么是规格说明书？ 

设计完原型后，就可以输出Word格式的需求书或功能性规格说明书(Specification)。默认的规格说明书生成器是 

Word 2007 (.docx文件)，你不需要安装Word 2007也能生成和阅读.docx文件。只要你安装微软Office兼容包

（ Microsoft Office Compatibility Pack），就可以让Office2000/XP/2003打开、创建、编辑、保存2007格式文件

了。如果你未安装2007或兼容包，它会和 Axure一起安装。 另外，你也可以设置 Word2000作为规格书生成器。  

在设计线框图时，如果把需求说明或规格描述写在了页面注释或控件注释中，生成规格说明书时Axure会自动汇

总这些文字和插图，按照顺序出现在 Word文档中。  



 

 
   

 

点击阅读以下规格说明书范例，可以让你快速了解Axure 输出的规格书大概是什么样子（来自

http://userxper.com，是一个台湾的Axure 网站）。 

  Axure RP Prototype 范例-旅游网站企划书(Word 2000 格式) 1.7 M bytes 

 Axure RP Prototype 范例-旅游网站企划书(Word 2007 格式) 700 k Bytes 

 

2、配置和生成规格说明书  

要配置生成的规格说明书，选择主菜单―Generate->Specification(F6)‖或点击工具栏中的―Specification‖按钮，在 

Configure Word 2007 Specification 对话框中，可以设置输出的内容和格式： 

 常规（General） ：生成的规格说明书存放的目录； 

 页面（Pages）： 选择要包含哪些页面； 

 模块（Masters）：选择要包含那些模块。可以设置是否将模块显示在页面部分； 

 页面注释（Notes）：选择在规格说明书中显示那些页面注释项和显示的顺序； 

 界面插图（Screenshot）：选择是否显示线框图插图； 

 控件注释（Annotations）：选择显示哪些控件注释项和显示的顺序。点击Add New Table 按钮，可以将控件

注释项分成多个表格，在表格中设置要显示哪些注释项和显示的顺序。 

 控件（Widgets）： 可以设置特定控件的配置。例如，可以设置在说明书中显示下拉列表框，并可以指定要显

示的标题。 

 Word 模板（Word Template）： 为规格说明书设置文档模板。点击― Import Axure Template‖可以导入预置的

axure中的模板，或点击― import‖导入自己的模板。一个模板是一个标准的.docx 文件，在.docx文件中的

―[[INSERT AXURE SPEC]]‖位置会自动生成规格说明书的内容。另外，还可以设置是两栏布局，还是单栏布局。

http://userxper.com/samples/zh/Spec/demo_travelsite.doc
http://userxper.com/samples/zh/Spec/UserXper-TravelSite-Sample.docx


 

 
   

设定word模板可以客户化输出的规格文档，让文档的表现的更专业，也可以事先设定好前言和附录文件，如封

面、 附录、 签名页。还可以修改 Word模板来配置规格中的文字样式，改变文件的排版或加入页首、页尾。  

 

 

3、发布规格说明书 

 Word 2007规格说明书生成器会创建一个 Word 2007（.docx）文件，该文件可以被 Microsoft Word 2007打开，

也可以被安装有微软Office兼容包（Microsoft Office Compatibility pack）的Word 2000、 XP和 2003打开。如果

你发布文档到没有安装Word 2007或微软Office兼容包的客户或同事那里，你可以发布为较早版本的Word文档。 

 

 

 

 

第二章 流程图 
 

第1节 流程图和连接线 
 

1、什么是流程图 



 

 
   

流程图是产品团队沟通信息架构和交互设计的最基本工具，在一个宏观程度上描述产品的用户体验过程。一个流

程图可用于展示各种各样的处理流程，包括用例流程、商业流程、页面流程等。在Axure中，流程图常用于展示

所设计的原型能完成的任务的更高层次的视图。一张简明的流程图，能促进和其它设计师、开发工程师的交流，

节约口头沟通的成本，并且能点出一些关键性问题。流程图能使思路清晰、逻辑清楚，并且有助于程序的逻辑实

现和有效解决实际问题。 

 

在Axure中，流程图其实也是页面（也就是说Axure中页面分为两种类型：流程图和线框图），只要修改页面类型

为流程图即可：在页面上点击右键，选择―Diagram Type->Flow‖，这时的页面前的图标会变为一个 图标。 

  

注意：在Axure中要创建流程图并不是一定强制要将页面指定为流程图，指定为流程图只是方便识别当前页面是

一个流程图。 

 

2、流程控件 

在控件面板中的顶部工具栏上点击下拉菜单，选择―Flow‖菜单项，就可以找到流程控件，这些不同的流程控件用

于表达流程图中的步骤。Axure里面由于不涉及到具体的程序流程，所以有些标准的图形并没有提供，如不规则

图形、侧面双矩形等，如果这些流程控件不满足你的流程图需要，可使用图片控件进行合成。 

 

流程控件的使用有一些约定习惯，但是Axure并没有对如何使用这些形状进行强制约束。一般地，你应该以其他

人能够理解的方式进行使用。你也可以自定义一套符号标准，在团队中进行统一使用。 



 

 
   

 
 

我建议大家可以参照Jesse James Garrett  的描述信息结构和交互设计的图示词汇表 所介绍的各个图示去使用

Axure中的流程图控件。以下仅对默认的流程控件作简要说明（欢迎大家对如何使用这些流程图控件，或如何建

立更多的流程图控件和标准用法进行讨论，）： 

 

rectangle：矩形 

作用：表示一个页面。 

 

rounded rectangle：圆角矩形 

作用：用来表达一个区域，这个区域中包含了一组页面，这些页面通常有一些共同属性（如都是出现在一个弹出

窗口，或者有一些共同的设计特征）。这样做的目的是将整张流程图分隔为几个部分，并为每个部分单独命名，

从视觉上使复杂的流程图变得更为清晰，在沟通时也方便。 

 

 

beveled rectangle：斜角矩形 

作用：表示可重用的流程模块，用于避免反复描述一系列相同的步骤。比如一个用户登录的流程。 

http://blog.jjg.net/
http://www.jjg.net/ia/visvocab/chinese.html


 

 
   

 

 

diamond：菱形 

作用：表示决策或判断（例如：If…Then…Else）,在程序流程图中，用作判别框。 

 

file：文件 

作用：表示一个独立的文件，如声音、图片、PDF文件等。 

 

bracket：方括号 

作用：当流程图太大时，为了易于阅读，可以将流程图的一些部分拆解成单独的模块，方括号就是用于表达这个

拆分出来的模块的链接点。 

 

 

semicircle：半圆形 

作用：表示同时并发执行多个结果。例如当用户点击一个软件下载页面时，同时载入软件安装介绍页面和下载软

件文件。 



 

 
   

 

 

triangle：三角形 

作用：表示单项选择的条件分支，参见Jesse James Garrett  的描述信息结构和交互设计的图示词汇表 。 

 

 

trapezoid：梯形 

作用：表示多项选择的条件分支，参见Jesse James Garrett  的描述信息结构和交互设计的图示词汇表 。 

 

 

ellipse：椭圆形或圆形 

作用：如果画圆形，可表示多个路径流程的群组（集合），群组可以作为条件分支或条件选择器的下游元素。 如

果是画成椭圆形，可表示流程的开始和结束。 

http://blog.jjg.net/
http://www.jjg.net/ia/visvocab/chinese.html
http://blog.jjg.net/
http://www.jjg.net/ia/visvocab/chinese.html


 

 
   

             

hexagon：六边形 

作用：暂无。 

 

parallelogram：平行四边形 

作用：暂无。 

 

actor：角色 

作用：来自于use case 用例，模拟流程中执行操作的角色是谁。需要注意的时，角色并非一定是人，有时候是

机器自动执行，有时候也可是模拟一个系统管理。 

 

database：数据 

作用：就是指保存我们网站数据的数据库。 

 

image：图片 

作用：表示一张图片，或者置入一个已经画好的图片、流程或者一个环境。 

 

3、流程连接线 

流程图控件和线框图控件的不同点在于流程控件可以通过连接线进行连接。要添加连接线，可以点击主工具栏上

的―Connector Mode (F11)‖按钮，这时线框图区域会从指针状态切换到连接状态，再点击―Pointer Mode (F9)‖可

以切换回到指针状态。 

 

 

在连接状态时，在流程图中点击和拖动就可以绘制和添加连接线。例如，要连接两个流程控件，将鼠标放在一个

流程控件的连接点上，点击和拖拉，然后鼠标在另一个目标流程控件的连接点上松开，就可以完成连接。点击和

拖动连接线的尾部端点可进行重新连接。 



 

 
   

 

选择流程连接线，然后点击工具栏中的―Line Pattern ‖和― Line Ends‖按钮可以修改连接线的形状和样式，如箭头、

虚线。 

 

什么时候使用虚线？ 

当一个路径在某些条件成立的情况下再呈现给用户时，我们可以采用表达为虚线表示。例如对于一个包含员工信

息的页面来说，当用户是公司员工时该路径可通过，反之则不通过。  

 

 

4、创建流程图 

与线框图控件相似，你可以拖曳流程图控件到线框图中，可以通过工具栏和右键菜单来修改流程图形状的风格和

属性。另外，已经绘制好的流程形状可以通过控件右键菜单中的―Edit Flow Shape‖的子菜单进行流程图形的转变。 

 

 



 

 
   

5、流程图中引用页面 

可以在流程图控件上分配一个引用页面，如果流程图控件引用了一个页面，控件上的文本会变成页面的名称。在

HTML原型中点击引用了页面的流程控件可以自动链接到对应页面中。 

 

在站点地图面板中拖曳页面到线框图或流程图中，将会创建一个引用了页面的流程图控件。流程图控件上所引用

的页面可以通过在控件上的右键菜单 ―Edit Flow Shape->Edit Reference Page‖进行编辑和清除。 

 

 

引用页面后，控件左上角会有一个 图标进行标识： 

 

 

第2节 自动生成流程图 
 
可以根据站点地图面板中的页面层级关系自动产生流程图： 

1、首先，创建一个流程图页面，并双击打开； 



 

 
   

2、然后，在站点地图面板中你想要生成流程图的分支根节点上点击右键，然后选择―Generate Flow Diagram‖，

你将看到两个选项：―标准流程图（Standard digram）‖或"右朝向流程图（Right Hanging）"。选择其中一个就可

以在线框图面板中产生一个流程图。 

  

所生成的流程图是根据你所选择的页面和子页面的层级关系，并且会自动引用对应的页面。可以像一般的流程图

一样编辑修改自动生成的流程图。 

 

 

 

第三章 高级交互设计 
 
本章中介绍了用于设计高保真原型所需要的一些复杂的交互行为 

 

第1节 动态面板 
 

1、动态面板控件 

动态面板控件（Dynamic Panel）可以让你实现高级的交互功能，实现原型的高保真度。 

动态面板包含有多个状态（states），每个状态可包含一系列控件（你可以把一个状态理解成一个独立的页面）。

任何时候都只有一个状态（页面）是可见的，或整个动态面板可以被隐藏。结合交互动作，可以让动态面板的状

态进行隐藏、显示和改变。像添加其它控件一样，可以在控件面板中拖放动态面板控件到线框图中。 

 

2、编辑动态面板的状态 



 

 
   

在线框图中，双击动态面板控件可以打开一个动态面板状态管理器（Dynamic Panel State Manager）对话框，

在对话框中你可以创建、重命名、重新排序、删除和编辑动态面板的状态。 

 

第一个状态是动态面板的默认状态。在对话框中选中一个状态，然后点击―Edit State‖按钮，就可以中打开一个页

面对这个状态进行设计。进行状态设计和设计线框图是一样的。要注意的是，状态页面中的蓝色虚线外框表示动

态面板的边界范围，超过这个边界范围外的物体在最终生成原型时将不可见。 

 

3、隐藏动态面板 

可以设置动态面板在默认时隐藏。只要选择动态面板，右键菜单选择―Edit Dynamic Panel->Set Hidden‖即可。这

将会隐藏面板内容，动态面板的遮罩会由蓝色变为黄色。 

 
 



 

 
   

4、动态面板的管理 

动态面板管理器(Dynamic Panel Manager)提供了管理页面中所有动态面板的功能，可以在主菜单上选择

―View->Dynamic Panel Manager‖来调出动态面板管理器。 

 
动态面板管理器 

 

动态面板的状态可以通过动态面板管理器进行新增、移除、编辑。在动态面板名称或状态名称上点击鼠标右键会

弹出一个右键菜单，使用这个菜单可以新增、移除状态。在状态名称上双击鼠标左键，就可以打开状态页面进行

编辑。 

 

另外，为了更方便的设计线框图，动态面板管理器中还提供了暂时隐藏或显示动态面板的功能。用鼠标点击动态

面板名称右侧的淡蓝色小方块 ，可以在隐藏或显示之间切换。或者，你可以在顶部的页面名称（如Home）

上点击鼠标右键，选择右键菜单―Hide All ‖或―Show All‖，可以隐藏或显示页面中所有的动态面板。 



 

 
   

 

 
 

4、动态面板的交互行为 

可以在动态面板上使用一些交互行为。目前在Axure5.5中在交互场景属性（Interaction Case Properties）对话框

中包含了以下常用在动态面板上的交互行为： 

Set Panel state(s) to State(s) 

Show Panel(s) 

Hide Panel(s) 

Toggle Visibility for Panel(s)  

Move Panel(s) 

Bring Panel(s) to Front 

 

选择其中一个行为后，然后可在对话框底部的Step 3区域中选择要进行交互的动态面板和状态，即可实现动态面

板的交互行为。 



 

 
   

 

在控件交互面板上Label输入框中，可以对线框图中选择的动态面板进行命名，然后就可以使用这个名称去引用

动态面板。如果没有为动态面板进行命名，动态面板会被默认命名为―Unlabeled‖。 

 

 

5、动态面板的应用举例 

Tab页签 

动态面板可用于创建一个Tab页签控件。例如，Tab页签控件有3个页签，则可以使用一个包含有3个状态的动态

面板，每一个动态面板的状态代表一个打开的页签状态。然后在每个页签上设置一个交互动作（OnClick），当

点击某个页签时，切换到动态面板的对应的某一个状态。 



 

 
   

 

下载样例文件：DynamicPanelsSamples.rp 

查看演示Demo：DynamicPanelsSamples  

 

弹出菜单 

动态面板可以用于在原型中自定义弹出菜单，根据鼠标的移动动态的显示和隐藏菜单，这可以结合OnMouseEnter

事件和动作来实现。 

 

下载样例文件：MouseOverMenuSample.rp 

查看演示Demo：MouseOverMenuSample   

 

页面动态初始化 

动态面板可以和页面的OnPageLoad事件结合使用，实现根据变量的值呈现不同的初始化界面（根据变量值呈现

不同的默认动态面板的状态）。 

http://www.axure.com/samples/DynamicPanelsSamples.rp
http://www.axure.com/samples/DynamicPanelsSamples/index.html
http://www.axure.com/Samples/MouseOverMenuSample.rp
http://www.axure.com/Samples/MouseOverMenuSample/index.html


 

 
   

 

第2节 翻转效果和鼠标移动事件 
 

1、OnMouseEnter和OnMouseOut事件 

在文本类控件、按钮类控件、超级链接控件中有OnMouseEnter和 OnMouseOut事件。OnMouseEnter事件是当

鼠标移入到一个控件上时发生，OnMouseOut事件是当鼠标移出一个控件时发生。 

 

OnMouseEnter 和 OnMouseOut事件常常和动态面板一起使用，在原型中实现如菜单弹出、状态翻转、自定义

提示等功能。 

 

2、图片翻转和按钮样式翻转 

不使用OnMouseEnter, OnMouseOut和动态面板，也可实现图片翻转、按钮样式翻转。 

 

图片翻转 

拖入image控件到线框图中，右键菜单选择―Edit Image->Import Rollover Image‖，然后选择一张翻转图。用鼠标

移入到线框图中图片上的―黑白‖小方框上进行效果预览。 

 

按钮样式翻转 

拖入Rectangle控件到线框图中，右键菜单选择―Edit Button Shape->Edit Rollover Style‖，在Set Rollover Style

对话框中可以修改翻转的样式。应用样式后，在线框图中用鼠标移入到线框图中按钮左上角的―黑白‖小方框上进

行效果预览。 

 

 

第3节 按下、选中、停用的效果 
 



 

 
   

图片(Image)及按钮形状(Button Shape)控件不仅具有鼠标悬停样式 (Rollover Style)，还可以设置鼠标按下时的

样式、选中时的样式(Selected Style) 、停用时的样式(Disabled Style)。这些样式可以用来设计自定义的交互按

钮或页签。 

 

 

要设置被选中时的样式(Selected Style)则必须配合交互动作中的―Set Widget(s) to Selected State‖这个行为。 

 

要设置停用时的样式(Disabled Style)则必须配合交互动作中的―Disable Widget(s)‖这个行为。 

 

被选中时的样式(Selected Style)也可以借用OnPageLoad页面触发事件来突显某个菜单项或导航项。 



 

 
   

 

 

 

 

第4节 菜单 
 

1、菜单控件 

菜单控件用于创建简单的弹出菜单，如一般桌面应用软件中的菜单。 

菜单控件分为垂直菜单（Vertical Menu）和水平菜单（Horizontal Menu），可以通过控件面板中拖入菜单控件到

线框图中创建菜单，默认情况下菜单带有3个菜单项。 

 



 

 
   

 

2、编辑菜单控件 

双击菜单项可以编辑菜单文本，通过工具栏可以对菜单加底色、字体和其它样式。右键单击选择―Edit Menu 

Padding‖，在弹出的Menu Padding Editor对话框中可设置边距。 

 

 

要增加或删除菜单项，右键单击选择―Add Menu Item ‖和―Delete Menu Item‖。 

 

 

要为某个菜单项添加子菜单，在菜单项上右键单击选择―Add Submenu‖。 



 

 
   

 

 

3、菜单样式翻转 

右键单击菜单或菜单项，选择―Edit Rollover Style‖，在弹出的―Set Rollover Style‖对话框中你可以为一个菜单项、

所有菜单项、所有子菜单添加动态样式翻转效果。选择Preview复选框，你可以对所应用的菜单样式翻转效果进

行预览。 

应用样式之后，可以将鼠标移到菜单项左上角的黑白小方框 上进行翻转效果预览。 

 

 

第四章 高级功能 
 

第1节 逻辑条件 
 

1、什么是逻辑条件 

良好的场景说明（Case description）可以成为一个有效的流程沟通的方法，且非常易于维护和更新。但如果需

要更强大、更高保真度的原型，就需要逻辑条件（Conditional Logic）。 

 

可以在你设计的任何交互中添加逻辑条件，条件可以是基于原型中控件上输入的值，如复选框的选择值、文本框

中的文本等。另外，条件也可以是基于变量值。 

 

2、创建逻辑条件 

要添加逻辑条件，首先要在交互面板中为某个事件添加一个场景（case）。在Interaction Case Properties对话框

中的Step 1中点击―Add Condition‖这个链接。 



 

 
   

 

 

这时会打开一个Condition Builder对话框，该对话框用于创建逻辑条件，如： 

―If text on widget UsernameField equals 'axure' and text on widget PasswordField equals '12345'‖。 

 

以上这逻辑条件的意思是：如果名称为―UsernameField‖的控件上的文本等于―axure‖，并且名称为―PasswordField‖

的控件上的文本等于―12345‖ 

 



 

 
   

 

 

在Condition Builder对话框中，可以添加多个逻辑条件。点击―+‖按钮可以增加一行逻辑条件，点击―-‖按钮可以删

除一行逻辑条件。 

 

如果要求所有条件都需要满足，则在Satisfy下拉列表框中选择―all ‖，即各个条件行之间是―And‖关系；如果Satisfy

下拉列表框中选择为―any‖，则只要满足其中一个条件，即各个条件行之间是―or‖关系。 

 

在一个条件语句中，有以下6种类型的值可以使用： 

文本框、文本域中的文本 

复选框和单选按钮的选择值（选择或未选择） 

下拉列表框、列表框中的选择项 

控件值的长度 

变量值 

变量值的长度  

 

在Condition Builder对话框中点击Ok按钮，回到Interaction Case Properties对话框，这时就可以选择当条件满足

时要执行的动作了。 

 

当在触发事件上使用了条件后，这时在控件交互面板中的场景说明（如Case 1）位置后面包含了一个―If‖条件语句

描述，同时 OnClick事件前面的图标也被加为高亮的绿。 

 

 

 

在事件的一个场景上定义了一个条件后，为事件的后面其它场景添加的条件语句的前面会默认带有―Else If‖。如

果后面场景没有添加条件，则会默认为―Else If True‖  



 

 
   

 

 

 

默认情况下，当条件语句的值为―True‖时，原型中只会执行第一个场景。―Else If‖可以被修改为―If‖，只要在交互面

板中右键单击场景，选择―Change to IF‖菜单。这样，只要多个条件都成立，就可以执行多个动作。 

 

 

第2节 OnChange事件 
 

1、什么是OnChange事件 

OnChange事件可用于下拉框（Droplist）和列表框（List Box）控件。OnChange事件是在下拉框或列表框的选

项选择时发生。这在原型中以下拉框进行导航非常有用，即当选择下拉框的某个选项时跳转到相应的页面上。 

 



 

 
   

 

2、在OnChange事件上使用逻辑条件 

在OnChange事件中的场景上也可以添加逻辑条件。在Interaction Case Properties对话框中的Step 1中点击―Add 

Condition‖，然后在Condition Builder对话框中设置条件。 

 

在OnChange事件上的场景中，可以用―selected option of‖条件语句，进行下拉框或列表框中的值对比，例如―if 

selected option of droplist equals selected option of listbox‖（这句逻辑条件的意思是：如果名称为droplist下拉框

的选项等于名称为listbox列表框的选项）。 

 

 

第3节 OnKeyUp事件 
 

1、什么OnKeyUp事件 

OnKeyUp事件可用在Text Field 和 Text Area控件上，当用户在控件中进行输入然后松开键盘按键时触发。常用

于打字时的对键盘的响应。 

 

2、OnKeyUp实时表单验证 

OnKeyUp事件常用于用户在表单中进行输入的实时校验。例如，验证输入的字符长度、用户名是否已经存在、验

证码是否正确等，并在界面上进行动态信息提示。  

 

 

下图是用OnKeyUp事件实现的当输入的邮编不符合5个字符长度的两个状态： 



 

 
   

 

 

 

第4节 OnFocus和OnLostFocus事件 
 

1、什么是OnFocus 和OnLostFocus事件 

OnFocus和OnLostFocus事件可用于Text Field, Text Area, DropList, List Box, Checkbox 和 Radio Button控件

上。OnFocus事件是当是当鼠标点击控件或用键盘tab键让控件获得焦点时发生；而OnLostFocus事件正好相反，

是当控件失去焦点时发生。 

 

2、使用场合举例 

OnFocus 和 OnLostFocus常用于显示、隐藏与表单中控件相关的动态信息。OnLostFocus也常用于当控件失去

焦点时，触发对控件中输入的数据的验证。 

 

第5节 变量 
 

1、什么是变量 

变量用于在HTML原型中进行点击时的页面之间的传递和存储数据，这样变量能在页面之间保持下去。Axure文件

中可最多使用25个变量。变量可以在交互设计和逻辑条件中使用。 

 

2、管理变量 

在主菜单中选择―Wireframe->Manage Variables‖，在弹出的Manage Variables对话框可以进行变量的添加、删除、

重命名、排序。 

 

默认时，每个页面中都有一个OnLoadVariable变量。新创建的变量的名必须为字符和数字，不能大于25个字符长

度，且不能含有空格。 



 

 
   

 

 

3、设置变量的值 

在添加场景时弹出的―Interactions Case Properties‖对话框中，只要在step2中选择 ―Set Variable and Widget 

Value(s) equal to Value(s)‖这个动作，然后在step3中点击―Variable and Widget value equal to Value‖这个链接，

就可以在弹出的Set Variable and Widget Value对话框中设置变量的值了。 

 

 

在以上对话框中，可以设置动作如：―Set value of variable OnLoadVariable equal to ‗loggedin‘‖，即让变量

OnLoadVariable的值等于―loggedin‖。 

 

4、在条件中使用变量 



 

 
   

在Condition Builder对话框中，可以在设定的条件中使用变量，例如―if value of variable OnLoadVariable equals 

‗loggedin‘‖，即如果变量OnLoadVariable的值等于‗loggedin‘时。 

 

 

5、设置文本时使用变量 

当使用动作Set Variable and Widget Value(s) equal to Value(s)设置文本内容时，可以在文本面板中插入变量值。 

 

 

当在文本类控件中编辑文本时，在Set Variable and Widget Values对话框中你可以用符号―[[ ‖和 ―]]‖包住一个变量

名，就可以在原型中插入变量的值。 

 

例如，可以设置text panel控件的文本为―Welcome, [[NameVariable]]‖。在原型执行时，其中的― [[NameVariable]]‖

会被实际的变量的值代替。 



 

 
   

 

 

第6节 OnPageLoad事件 
 

1、什么是 OnPageLoad事件 

原型中加载页面时，会发生OnPageLoad事件。OnPageLoad事件常用于设置动态面板的状态、控件的值、或页

面载入时弹出一个窗口。 

 

模块上也有OnPageLoad事件，当包含模块的页面载入这个模块时，模块上的OnPageLoad事件就会发生。页面

上的OnPageLoad事件触发后才触发模块上的OnPageLoad事件。 

 

OnPageLoad事件是在页面注释和交互区的Interactions区域中进行定义，在OnPageLoad事件上添加场景的方法

和在控件事件上添加场景的方式相同。 

 

 

 

2、OnPageLoad事件和变量 

OnPageLoad事件常和变量一起使用，以达到在原型中的页面之间传递变量值的目的。 

 

OnPageLoad事件中常有基于变量值的逻辑条件的场景。例如，你可能会根据变量的值去设定页面载入时的动态

面板的状态，显示一个用户是否已经登陆。或者，你可能用存储在变量中的用户名去设置text panel控件中的文本，

如：―Welcome, [[UsernameVariable]]‖，设置页面载入时的对当前用户的欢迎信息。 

 



 

 
   

第7节 高级交互设计编辑器 
 
在交互场景属性(Interaction Case Properties)对话窗新增了高级编辑器的功能，只要在对话框中点击―Advanced 

Editor‖这个链接即可打开高级编辑器，然后点击―Basic Editor‖可以回到原来的基本编辑器。 

 

 

基本编辑器可以一次显示所有支持的交互行为，只要进行勾选就可以设定交互行为，而且会依照默认的顺序来执

行多个交互行为。如果是采用了高级编辑器，你就可以自定义交互行为的顺序，而且相同的交互行为可以进行多

次的展现。 



 

 
   

 

 

当用动态面板（Dynamic Panel）展现动画效果时，就可以使用高级编辑器来进行交互设计。比如在某个动态面

板中，用高级编辑器来控制每个State(状态)的出现顺序与出现的间隔时间，以表现出动画效果。想要做到这样子

的交互设计，就必须按照―Set Panel State(s) to State(s)‖接着‖Wait Time(ms)‖ 的顺序，重复增加多个行为表现，

这就是高级编辑器与基本编辑器的差别。基本编辑器只能针对相同的事件来执行一次交互行为，而高级编辑器却

可以加入更多的动作表现，而且可以重复执行多次该动作 (如下图)。 

 

当某一种交互行为已经被使用多次了，返回基本编辑器的链接就会失效，因为这种设定方式无法通过基本编辑器

的窗口来表现行为的执行顺序了。 



 

 
   

 

 

 

 

第五章 模块的有效重复使用 
 

第1节 控制模块中的控件 
 

1、模块的重用 

模块的重要作用就是重复使用。你可以将设计中可重用的部分做成模块，只需要改变模块中的一个地方，就可以

修改所有相关的地方，使得维护非常方便。 

 



 

 
   

有时，可能需要让模块在不同的页面上有所不同。例如，对于作为导航元素的模块，在不同页面上所要突出显示

的―当前导航项‖要不同；或者对于作为Header头部的模块，在不同页面上时需要显示不同的标题文字。虽然这些

应用例子也可以通过为每个页面创建一个额外的模块或在每个页面上做一些特别的编辑来实现，但是利用一些特

别的功能，使得仍然可以只在一个模块中进行维护，做到模块的有效重用。 

 

2、模块中的动态面板 

在页面中可以操作所使用的模块中的动态面板。例如，页面OnPageLoad事件可以隐藏页面中所使用的模块中的

动态面板，在所选择的模块下面会列出模块中的每个动态面板。 

 

 

如果模块中的一个部分只在某些页面上显示而在其它页面上不显示，这可以通过设置模块中的动态面板的状态来

实现。所以你可以只需要维护一个单独的模块，最大化的实现模块的重复使用。 

 

3、模块中的控件值 

在页面中可以操作所包含的模块中的控件。 

 



 

 
   

例如，在页面的OnPageLoad事件上，在交互行为"Set Variable and Widget value equal to Value"中，你可以对

所使用的模块中的text panel控件设置文本。当你选择―text on widget‖设置控件的文本时，将看到在所选择的模块

下列出了模块中所包含的控件。 

 

 

如果一个模块中的文本控件在不同页面上有不同的文本，你仍然可以只在一个单独的模块中进行维护，达到模块

最大化利用。 

 

4、设置逻辑条件 

同样，也可以在页面的逻辑条件中使用页面中所包含的模块中的控件。（注意：这时只能引用到模块中包含的

TextField，TextArea这样的控件） 

 

 

第2节 模块上的自定义事件 
 

1、什么是模块上的自定义事件 

可以在模块上自定义一些事件。 

以下情况时，可以使用自定义事件： 

 当需要在一个模块的不同引用实例上实现不同的交互时； 



 

 
   

 当你和一个模块进行交互时，模块内的控件要对在模块之外的控件进行操作。 

 

以下情况时，不要使用自定义事件： 

 当你和一个模块的交互在所有模块的引用实例上都一样时； 

 当你和一个模块进行交互时，不需要让模块内的控件对模块之外的控件进行操作时。 

2、管理自定义事件 

要为模块添加自定义事件，首先必须中打开模块，然后点击主菜单―Wireframe->Manage Raised Events（Masters 

Only…）‖，在打开的Manage Raise Event对话框中可以管理自定义事件：添加、删除、重命名、排序。 

 

 

任何在模块中的控件都可以触发模块的自定义事件。例如，模块中的按钮OnClick事件可以包含一个触发Raised 

Event交互行为。这可以通过在Interacton Case Properties对话框中选择Raise Event交互行为实现。 



 

 
   

 

 

在上图中，点击―Event‖链接，在所打开的Manage Raised Events对话框中选择要触发的模块自定义事件。 

 

 

最后，当你在线框图中使用这个带自定义事件的模块时，在控件交互面板上你可以看到这个自定义事件。模块自

定义事件可以像其它事件一样添加场景、逻辑条件和交互行为。 



 

 
   

 

 

第六章 多人协助和版本管理 
 

第1节 创建共享工程 
 

1、什么是共享工程 

一个共享工程是可以被多人同时编辑，共享工程中也保存着工程被修订的历史。 

 

一个共享工程是被存储在一个普通的文件目录中，该目录可以被那些允许访问共享工程的网络上的人所访问。

Axure共享工程所存储的服务器或计算机上不需要安装额外的软件。 

 

 

在Axure中操作一个共享工程和在版本控制系统中操作文件是类似的，每个人在自己本地计算机上都有一个共享

工程的副本。如果要修改页面、模块、或工程属性，首先需要对这些项目进行检出（checked out），等完成修改

后，再进行检入（checked in）到共享工程中，其它人就可以在本地获取所更新的共享工程了。事实上，就是用

SVN在进行共享工程的版本控制。 

 

2、创建共享工程 

通过主菜单―File->New Shared Project‖，就可以创建一个新共享工程。这时会弹出一个创建共享工程的对话框，

根据指示去输入工程名、共享工程的目录地址、本地共享工程的副本。 



 

 
   

 

 

创建共享工程后，在你的本地计算机上会有一个―ProjectName.rpprj‖文件，并会自动打开。今后只要打开这个

―ProjectName.rpprj‖文件，就可以操作共享工程，而不需要再从远程的共享工程中去获取，除非你想创建一个新

的副本。 

 

本地共享工程目录中，有一个.rpprj文件和一个DO_NOT_EDIT文件夹，DO_NOT_EDIT文件夹中包含了工程数据

和版本控制信息，不能在Axure以外进行编辑。如果你要移动.rpprj文件，同时你也要一起移动DO_NOT_EDIT这

个文件夹。 

 

 



 

 
   

在网络共享目录中，包含有共享工程，该共享工程中包含有和SVN关联的一系列文件和目录。如果你不熟悉SVN，

也不应该直接去修改这些目录中的内容。 

 

 

3、从已有RP文件创建共享工程 

已有的.rp文件可以被转化为共享工程。打开.rp文件，然后选择主菜单―Share->Create Shared Project from 

Current File‖，这时也会打开创建共享工程的对话框，进行工程的设置。 

 

在共享工程创建之后，在你的本地目录中会有一个―ProjectName.rpprj‖文件，打开这个文件就可以操作共享工程。

原来的.rp文件和共享工程没有产生关联。 

 

4、获取共享工程 

为了操作一个共享工程，你使用的计算机上必须有一个共享工程的本地副本。要获得共享工程的一个本地副本，

选择主菜单―Share->Get and Open Shared Project‖，这时会弹出获取共享工程的对话框 



 

 
   

 

 

如果在你的计算机上已经有一个原先创建的共享工程的副本文件，即―ProjectName.rpprj‖文件，你可以直接打开

该文件就可以操作共享工程。 

 

如果从一个计算机上直接拷贝共享工程的本地副本到另一计算机上，会导致工程的冲突。如果你在多个计算机上

工作，可以在还没有共享工程本地副本的计算机上通过主菜单―Share->Get and Open Shared Project‖获取和打

开共享工程。 

 

说明：ProjectName 由你实际创建的工程名称代替。 

 

第2节 操作共享工程 
 

1、编辑共享工程 

打开Axure共享工程后， Axure的环境会有一些改变。在Sitemap面板中的页面和Masters面板中的模块前面会有

一些不同的图标，表示页面和模块的状态。 



 

 
   

 

 

另外，在所打开的线框图的上面有一个工具栏，包含了当前状态信息和修改状态的按钮。  

 

 

如果要修改页面或模块，要进行检出（Check Out）。要共享你的修改，可以发送修改（Send Changes）；或者

你如果要提交修改，可以进行检入（Check In）。要获取最新更改，使用获取修改（Get Changes）。 

  

工程属性包含有控件注释项、页面注释项、变量、样式和规格书生成器也需要检出（checked out）以进行修改。

而sitemap和master面板中的列表是个例外，它们可以不用检出就可以修改，这样可以让团队能够同时添加、删

除、组织页面。 

 

检出（Check Out） 

要在一个共享工程中编辑页面、模块、或工程属性，要先进行检出。要检出一个页面，在页面导航面板中右键点

击页面，选择―检出‖。页面检出时，会先对共享工程中已修改的页面和工程属性进行更新。在页面检出之后，就

可以进行正常的编辑，所检出的页面只能被你修改。 

 

如果你试图检出已经被检出的页面，则会出现警告信息。然而，这时你还是可以继续进行非安全检出（Unsafe 

Check Out），但并不提倡这样做，因为这有可能导致冲突。当多人同时对同一个页面进行修改时，就会发生冲

突。只有一个人的修改可以在共享工程中被存储，其它人的修改可能会丢失或被覆盖。非安全检出一般是在页面

（不论何种原因）不能从所检出的计算机上被检入，或你无法连接到共享目录的情况使用。 



 

 
   

 

 

提交修改（Send Changes） 

页面或模块的修改也可以通过提交从而被他人共享，这样在保持页面或模块在检出的同时，所作的修改能被他人

共享。 

 

检入（Check In） 

在页面或模块已经检出和编辑后，你可以通过File->Save进行本地保存，而这只是在你的本地计算机上进行共享

工程副本的保存。 

 

当你要将你的修改提交到共享工程上，就可以进行检入。要检入页面，在页面导航面板中，鼠标右键单击页面，

选择―检入‖。检入后，其他人就可以更新他们的本地共享工程副本看到你所做的修改，而你也就不再拥有页面的

编辑权，这时其它人就可以进行检出。 

 

检入一个页面，可能也需要你同时检入工程属性的修改。 

 

获取修改（Get Changes） 

要从共享工程中获取页面、模块、工程属性的最新修改，在页面导航面板中的页面上右键选择―Get Changes‖。

当获取页面的修改时，一些工程属性也可能会同时更新。通过主菜单―Share->Get All Changes from Shared 

Directory‖或工具栏上的―Get All Changes‖按钮达到更新。 



 

 
   

 

经常为本地共享工程副本去获取最新修改，这是个良好的习惯。 

 

页面列表和模块列表 

页面和模块列表不用检出，就能在共享工程的本地副本上进行添加、移动、删除、重命名，这样就能让多人同时

进行页面和模块的添加、删除和组织。如果多人同时进行了页面和模块列表的修改，在工程更新时会自动对列表

进行合并。 

 

要提交对页面和模块列表的修改,选择主菜单―Share->Send All Changes to Shared Directory‖或―Share-> Check 

In Everything‖将页面、模块、属性的所有修改发送到共享工程中。要更新本地副本，选择主菜单―Share->Get All 

Changes from Shared Project‖。 

 

以下是一个页面的编辑和修改共享的典型流程： 

 

1、周群在她自己本地的计算机上检出页面1进行编辑。由于同一时间只能有一个人检出同一个页面，所以这时李剑不

能检出修改页面1； 

2、周群提交修改和检入页面1到网络共享工程的目录中； 

3、李剑在他自己本地的计算机上获取周群对页面1的修改，且现在李剑可以检出页面1进行自己的修改。 

 

2、导出RP文件 

打开一个共享工程后，在主菜单选择―File->Export Shared Project to File‖，就可以导出一个共享工程到一个RP

文件。导出后，这个RP文件就可以像普通的RP文件一样被编辑，但已经后共享工程没有关联。 

 

要将RP文件做的修改合并到一个共享工程中，可以打开共享工程后然后使用―File->Import‖。但注意，如果你要

用导入的页面替换共享工程中的页面，必须先要对共享工程中的页面进行检出。 

 

3、查看共享工程的历史 



 

 
   

每次检入都会在一个共享目录中创建一个新的修订记录。对于每次检入，你可以添加备注，在修订中保留所作修

改的追踪。 

 

要查看和获取一个共享工程的修订历史，可使用主菜单―Share->Browse Shared Project History‖。 

 

 

在上面的历史浏览窗口中，你可以查看共享工程的所有历史修订和每次修订时的备注。你也可以导出一个修订到

RP文件中进行查看。 

 

4、使用共享工程管理器 

使用主菜单―Share->Manage Shared Project‖，可以打开一个共享工程管理器对话框，在该对话框中你可以查看

共享工程中每个项目的状态，例如哪个团队成员在对哪个页面或模块进行检出。 



 

 
   

 

右键单击刷新按钮你可以重新获取页面、模块、共享工程的文档属性。你也可以右键单击某个项目（行），选择

检入、检出、获取最近更新。 

 

5、移动共享工程目录 

如果一个共享工程被移动或共享工程的目录路径被改变，那么已有的共享工程的本地副本将不再指向正确的地

址。强烈建议在共享工程目录改变前对每个本地共享工程的副本先进行检入。 

 

要重新指向一个已有的本地共享工程到新的共享工程目录上，可打开已存在的副本，然后使用主菜单

―Share->Repoint to Moved Shared Directory‖。 

 

使用主菜单―Share->Get Shared Project‖，你也可以获取一个新的本地副本，但是如果你进行了任何的本地修改

或任何页面被检出，当共享工程被移动了时，这些修改和检出状态将不再被保留。 

 

6、结合SVN服务器 
  

默认时是使用一个文件服务器去存储共享工程，如果网络连接速度有限或你是通过VPN进行连接，则连接速度会

较慢。建立一个SVN服务器可以改善速度问题，因为SVN优化了数据传输。 

 



 

 
   

如果你对SVN不熟悉，网络上有一些免费的资源让你能够学习入门，如 http://svnbook.red-bean.com/ 。在

Windows环境下，有个免费的叫做VisualSVN的服务器可以自动帮助你建立一个SVN服务器。另外，你也可以选

择一个SVN主机托管服务器站点，如： 

 http://www.cvsdude.com 

 http://www.svnrepository.com 

 

在国内，我建议你使用： 

http://code.svnspot.com/ 

 

在你建立好你的SVN服务器后，你可以创建用户去访问SVN服务器。如果你是使用主机托管的SVN服务器站点，

应该有个界面让你添加一些用户。最后你可以使用你创建的共享工程目录的路径去链接到SVN服务器。 

 

 

 

实战篇 
 

案例一 登陆界面 
 

案例描述 

这是一个较为简单的登陆界面，输入用户名、密码后，点击登陆按钮进行登陆校验： 

1. 如果未输入用户名或密码，则提示―请输入用户名和密码‖，蓝色字体； 

2. 如果用户名或密码错误，则提示―用户名或密码错误‖，红色字体； 

3. 如果用户名和密码都匹配，则提示―您好，【用户名】‖，黑色字体。 

 

实现步骤 

步骤一、绘制线框图 

1、打开Axure软件，新建一个RP文件； 

2、拖动控件面板中的控件到线框图面板中，绘制登陆界面如下图： 

 

 

http://svnbook.red-bean.com/
http://www.visualsvn.com/
http://www.cvsdude.com/
http://www.svnrepository.com/
http://code.svnspot.com/


 

 
   

所用到的控件清单如下： 

控件名 作用 文本内容 标识符 其它属性 

Rectangle 装饰底板   底色：灰色 

Text Panel 信息提示 默认：登陆窗口 logInfo  

Text Panel 信息提示 用户名：   

Text Panel 信息提示 密码：   

Text Field 输入用户名  userName  

Text Field 输入密码  passWord  

Button 点击登录 登陆 submitButton  

 

 

步骤二、设计控件交互 

1、选中登陆按钮，在控件交互和注释面板中鼠标双击onClick事件； 

 

 

2、在弹出的―交互场景属性‖对话框中，点击―添加场景…‖这个链接；  



 

 
   

 

 

3、在弹出的―条件创建‖对话框中，添加条件如下： 

 

 

4、回到―交互场景属性‖对话框中，Step 2中选择动作―Set Variable and Widget value equal to Value‖，并点击Step 

3中的链接； 



 

 
   

 

 

5、在弹出的―设置变量和控件值‖对话框中，设置如下： 

 

 

点击―Edit text…‖链接，输入―请输入用户名或密码‖，并设置为蓝色； 

 

6、确定和关闭所有对话框，这时控件交互和注释面板如下： 



 

 
   

 

 

以上我们实现了第一个场景：如果未输入用户名或密码，则提示―请输入用户名和密码‖，蓝色字体； 

 

接下去，我们实现第2、3个场景，其步骤和实现场景1类似，只是要注意各个场景之间是―If else‖关系。最终控件

面板上的场景、条件、动作如下： 

 

 

步骤三、生成原型 

1、点击主菜单―Generate->Prototype…(F5)‖，选择要生成的原型地址，确定后就可以在浏览器中查看原型了。 

2、输入用户名和密码，点击登陆按钮，进行原型体验。 

  

 

 

 

 



 

 
   

技巧和提示 

 
1、解决中文输入法问题 

目前Axure对中文的一些输入法支持得不好，搜狗拼音输入法没有办法使用，用谷歌拼音问题不大，但会强制转

为全角，需要人为点击一下转为半角。 

2、超快速移动工作区 

当设计的页面画面变大时，为了选取不同位置的对象，必须经常使用垂直与水平的滚动条，这会使得选取对象的

动作变慢。请试试这招：鼠标光标focus在Wireframe中，按住键盘的空格键，此时鼠标光标会切换成手状，您可

以用来抓着画面任意滑动，而且不会打乱任何对象的位置，轻松愉快。 

3、穿透控件选取下层的控件  

以鼠标左键在对象上按住停留1秒钟以上，放开鼠标左键再单击下面的对象，可以穿透上层对象，选取到位于下

层的对象 。 

4、引用Microsoft Office或其他软件中的对象： 

利用复制、粘贴功能，将其他应用程序中如：PowerPoint, Excel, Visio, Photoshop 与Illustrator中的物件，粘贴

到Axure RP中。一般来说，这些粘贴的对象会变成Wireframe中的图形对象。反之亦然，也可以复制Axure中的

对象或画面，粘贴到其他应用程序。 

5、单选群组（Radio Button Group） 

您可以一次选取多个Radio Button，按下鼠标右键，并选择―Edit Radio Button->Assign Radio Group‖来设定Radio 

Button的群组关系。如此一来，当这些Radio Button输出到Prototype时，就会形成真正的单选用户接口。 

6、解除IE中的Active X 警告讯息 

使用IE打开在自己计算机里头的HTML原型时，浏览器中可能会出现Active X 警告讯息，想要暂时解除IE中的警

告讯息，请点选IE浏览器出现的Active X警示讯息，接着选择―允许被封锁的内容‖，这样就可以在IE浏览器上看到

自己计算机里头的HTML 原型了。 

7、只要输出必要的项目到规格书中 

规格文件输出时如果选择输出的项目太细，很有可能会产出一份好几百页的Word文件，难以阅读。因此，输出之

前最好通过格式的设定将不需要的项目取消勾选，只保留有意义的部份。 

8、默认规格书标题改成中文 

将Axure设置格式的文件标题改成中文，比如将Pages格式设定的 Section Header名称―Pages‖改成―软件规划说

明‖，把―Page Tree‖改成 ―界面列表‖；或者把Screenshot格式设定的 Section Header名称―User Interface‖改成 

―用户画面‖。如此一来输出成规格文件时，会更方便阅读这些段落标题。 

9、撤销操作 

有时想对Axure的某个面板（如站点地图面板或模块面板）中的操作进行恢复，只要在这个面板中点击鼠标（相

当于让焦点进入这个面板），然后按键盘的―Ctrl+Z‖键，就可以对这个面板中进行的操作进行恢复。 
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